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THIS IS AN EDITABLE DOCUMENT
Use this document if you wish to edit the COVID-19 Workplace Checklist to your business needs, after making your edits you will need to follow these few simple steps to enable the Yes / No tick boxes to be checked. 

For PC Users
Open the COVID-19 Business Restart Checklist document
Make any edits or additions you require to the document
Click on the File menu and select Options
Click on the Customize Ribbon menu
In the right column Customize the Ribbon, tick the Developer checkbox, so it will display the Developer menu in Word, then click OK
Click the Developer menu and click Restrict Editing button
Under 2. Editing restrictions, tick Allow only this type of editing in the document
And select Filling in forms in the dropdown
Click the button Yes, Start Enforcing Protection and enter a password
Click OK and Save the document
This enables the document to be a form that can be checked on and off in the check boxes.


For Mac Users
Open the COVID-19 Business Restart Checklist document
Make any edits or additions you require to the document
Click on the Word menu and select preferences
Click on the Ribbon & Toolbar menu and tick the Developer checkbox
Click the Save button
Click the Developer menu and click the Protect Form button
Save the document.


COVID-19
Workplace Checklist
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From 6.00pm on Friday 26 March 2021, 100% of employees are allowed back into their workplace (e.g., offices) and employers are no longer required to have employees working from home.
This template is intended to assist member businesses develop their own workplace checklist. The following information should be used as a guide only. Any wording changes, other than those to insert a business name, may change the context, meaning or purpose of the checklist. Therefore, we recommend you receive advice from the Victorian Chamber of Commerce and Industry prior to making such changes.  
For more information on our Health, Safety and Wellbeing consulting services contact 03 8662 5196 or email: hsw@victorianchamber.com.au
MANAGEMENT OF CRITICAL ACTIONS
	Ref
	Description
	Yes
	No

	1.1
	A centralised business action plan is in place and being used such as this document along with a COVIDSafe Plan or High Risk COVIDSafe Plan. All businesses, whether in Melbourne or in a Regional area of Victoria are required to have a plan in place.  If the business has more than one workplace, a COVIDSafe Plan must be in place for each site. A workplace Attendance Register also needs to be maintained for each business worksite.

	[bookmark: Check1]|_|
	[bookmark: Check2]|_|

	1.2
	The action plan outlines actions to be implemented prior to operational activity.
	[bookmark: Check3]|_|
	[bookmark: Check4]|_|

	1.3
	The action list is reviewed and updated regularly.
	[bookmark: Check5]|_|
	[bookmark: Check6]|_|

	1.4
	The action list incorporates roles and responsibilities of Managers and Employees along with restart timelines.
	[bookmark: Check7]|_|
	[bookmark: Check8]|_|

	1.5
	Observed evidence matches the reported status of actions and can be verified.
	[bookmark: Check9]|_|
	[bookmark: Check10]|_|

	1.6
	A systematic review of all relevant legal obligations required to be implemented (e.g., COVIDSafe Plan) has been undertaken and all documentation updated.
	[bookmark: Check13]|_|
	[bookmark: Check14]|_|

	1.7
	Ensure all visitors to the worksite are registered using their QR Code Scanner on their mobile phone or are signed into a register detailing the visitor’s name, the organisation they represent, their telephone/contact number, the time in and out along with details of the visitor’s contact person on-site and which area(s) of the site are to be visited.
	|_|
	|_|

	1.7
	Ensure loans with creditors and investors are reviewed to the Terms and Conditions of contracts etc., that may impact business operations in the longer term.
	[bookmark: Check15]|_|
	[bookmark: Check16]|_|

	1.9
	Consult with legal advisors, as necessary, for interpretation of, and potential liability for, shortfalls with government or regulatory requirements.
	[bookmark: Check17]|_|
	[bookmark: Check18]|_|



SITE PREPAREDNESS – INCLUDING SOCIAL DISTANCING
	Ref
	Description
	Yes
	No

	2.1
	Sanitisation sites provided – 1 for every 15 people.
	|_|
	|_|

	2.2
	Sanitisation sites include hand sanitiser; anti-bacterial wipes and a disposal bin.
	|_|
	|_|

	2.3
	Promote the use of hand sanitiser stations when entering the building or other locations on your worksite and ensure adequate supplies of hand soap and paper towels and/or hot air hand dryers in common facilities such as kitchens and toilet facilities.
	|_|
	|_|

	2.4
	Ensure all staff and any contractors are wearing appropriate personal protective equipment (PPE) including face masks unless these are not legally required e.g., outdoors or in offices or where a lawful exemption applies.  Employees must carry a face mask with them at all times and must be worn where they cannot maintain the safe social distance of 1.5 metres.  Also ensure adequate face masks and other required PPE is available for staff that do not have their own.
	|_|
	|_|

	2.5
	Employee inductions and refreshers include updated information related to current operations, legal requirements and external information to ensure the health and safety of all personnel.
	|_|
	|_|

	2.6
	Ensure all staff members are properly trained in the correct use and disposal of face masks and other PPE, on good hygiene practices, and other ways of slowing the spread of the coronavirus (COVID-19).
	|_|
	|_|

	2.7
	There is a documented contractor management plan or system in place.
	|_|
	|_|

	2.8
	Contractors are subjected to risk assessment prior to commencing operational activity.
	|_|
	|_|

	2.9
	One-way walkways are determined and marked accordingly.
	|_|
	|_|

	2.10
	1.5 metre distance marking is placed on floors.
	|_|
	|_|

	2.11
	Ensure workstation users have the mandatory 2 square metres per person and employees are 1.5 metres apart.
	|_|
	|_|

	2.12
	If 2.11 is not feasible, consider organisational modifications such as some employees working from home every other day or ½ day every day.
	|_|
	|_|



MANAGEMENT OF SITE DISINFECTION PRIOR TO AND DURING OCCUPATION
	Ref
	Description
	Yes
	No

	3.1
	Prior to re-occupation, worksites will be thoroughly cleaned and disinfected.  This must include all floors, hard surfaces e.g., cupboards, desktops, etc., toilets, showers, taps, door handles, handrails, reception, training rooms and client service areas.
	|_|
	|_|

	3.2
	Following restart, ensure high traffic areas, entrances to offices, client service areas and changes of staff (e.g., shift changes) are cleaned and disinfected twice daily along with toilets, showers, taps, door handles and handrails.
	|_|
	|_|

	3.3
	Ensure there are adequate supplies of cleaning products such as disinfectant and detergent.
	|_|
	|_|

	3.4
	Ensure meeting rooms provided with hand sanitiser; anti-bacterial wipes, a disposal bin and confirm these are used.
	|_|
	|_|

	3.5
	Ensure employees are provided with ongoing information regarding hygiene and cleaning/disinfection rules while on-site and when using pool or rental cars.
	|_|
	|_|



CRISIS COMMUNICATION
	Ref
	Description
	Yes
	No

	4.1
	Notify all employees of your site employee expansion/Restart programme.
	|_|
	|_|

	4.2
	Notify employees of the introduction of new physical changes.
	|_|
	|_|

	4.3
	Notify employees regarding any changed processes and operating procedures.
	|_|
	|_|

	4.4
	Notify employees of infection control processes introduced throughout business operations.
	|_|
	|_|

	4.5
	Ensure clients and suppliers are notified of any impacts regarding the delivery of services.
	|_|
	|_|

	4.6
	Ensure communications remain open and transparent with all suppliers, creditors and community stakeholders.
	|_|
	|_|

	4.7
	Changes to processes are displayed on a notice board for employees to action.
	|_|
	|_|



EMPLOYEE RESTART PROCESS
	Ref
	Description
	Yes
	No

	5.1
	Employees are notified of when they are expected to attend their workplace.
	|_|
	|_|

	5.2
	Executive management will determine who will return to work, and why.  They will then consult with and inform all employees.
	|_|
	|_|

	5.3
	Sites cleaned, disinfected, prepared for reoccupation and risk assessed.
	|_|
	|_|

	5.4
	Changes to maintenance processes and operating procedures are risk assessed and documented.
	|_|
	|_|

	5.7
	All personnel given restart dates as per Executive direction.
	|_|
	|_|

	5.8
	Hygiene (see part 7) and infection control (see part 3) processes reinforced throughout business operations.
	|_|
	|_|


CUSTOMER AND CLIENT SERVICES
	Ref
	Description
	Yes
	No

	6.1
	Ensure facilities and appropriate technologies are available to provide your customers with required services either face-to-face or on-line.
	|_|
	|_|

	6.2
	Ensure employees are thoroughly conversant with the procedures put in place for customer/client visits thus ensuring employee and customer/client health and safety whilst on-site.
	|_|
	|_|





HYGIENE MEASURES
	Ref
	Description
	Yes
	No

	7.1
	It is recommended that, where practicable, personnel entering worksites are temperature checked.
	|_|
	|_|

	7.2
	Ensure all employees are thoroughly conversant with, and following, all hygiene and social distancing rules (1.5m), including those for travelling to and from work on public transport (mandatory mask wearing) and hygiene when using work facility vehicles or rental cars.
	|_|
	|_|



VULNERABLE EMPLOYEES
	Ref
	Description
	Yes
	No

	8.1
	Identify all vulnerable employees e.g., those immune compromised, over 70, etc..
	|_|
	|_|

	8.2
	Ensure appropriate measures to protect vulnerable employees have been discussed by HR and/or relevant managers and the vulnerable employees and are in place.
	|_|
	|_|

	8.3
	Managers ensure that vulnerable people working in their areas of control are complying with the measures put in place to protect their health.
	|_|
	|_|



ACTION ON SUSPECTED OR CONFIRMED CASE(S) OF COVID-19
	Ref
	Description
	Yes
	No

	9.1
	Those who work in the same area must be required to leave the work area, wash their hands and wait while desks, associated equipment and surfaces in the work area are being cleaned and disinfected.
	|_|
	|_|

	9.2
	List the names of those employees who were in the work area or who may have had close contact with the person who is suspected of being infected or is infected during the previous 48 hours.
	|_|
	|_|

	9.3
	Notify WorkSafe Victoria of any case of COVID-19 in the workplace by contacting the WorkSafe Advisory Line on 1800 136 089 immediately.
	|_|
	|_|

	9.4
	Employees who have been in contact with someone who has contracted COVID-19 either at work or outside of work must be required to work from home and isolate until testing demonstrates they have not been affected by the exposure.
	|_|
	|_|





PROVISION OF PSYCHOLOGICAL SUPPORT
	Ref
	Description
	Yes
	No

	10.1
	Employees are given the EAP provider’s contact details.
	|_|
	|_|

	10.2
	Actions are taken to minimise additional sources of stress within and between teams.
	|_|
	|_|

	10.3
	Employees are encouraged by their managers and Human Resources personnel to openly communicate and express their feelings.
	|_|
	|_|

	10.4
	Appropriate health promotion information about the risks of COVID-19 and their management are provided.
	|_|
	|_|



CHANGE MANAGEMENT AND TRAINING
	Ref
	Description
	Yes
	No

	11.1
	Ensure the awareness of employees of measures to combat COVID-19 is raised and reminders are provided to motivate employees to adapt to the rules.
	|_|
	|_|

	11.2
	Ensure there is no imminent danger of significant incidents or impacts upon working conditions or the environment.
	|_|
	|_|

	11.3
	Implement, as appropriate, new safe work procedures/strategies to cope with the COVID-19 environment throughout the organisation and monitor their effectiveness.  
	|_|
	|_|

	11.4
	Review existing emergency responses and the Business Continuity Plan to include any new strategies and new control measures.
	|_|
	|_|

	11.5
	Prepare the workforce regarding decisions and actions to be taken to aid the recovery of business operations.
	|_|
	|_|

	11.6
	Appropriate health and safety personnel are contacted to ensure health hazards are clearly controlled in the workplace and compliant with all legal requirements.
	|_|
	|_|

	11.7
	Ensure adequate staffing levels to limit excessive work hours and reduce the likelihood of stress related issues.
	|_|
	|_|

	11.8
	Ensure health promotion communications are updated regularly to make sure known hazards and risks are well controlled and properly reported.
	|_|
	|_|

	11.9
	Ensure adequate amenities and Personal Protective Equipment (PPE) are available, accessible and correctly worn by employees and visitors, etc.
	|_|
	|_|



	11.10
	Confirm that regular employee refresher training sessions are planned and delivered to ensure hygiene and social distancing measures are being followed and are effective.
	|_|
	|_|

	11.11
	Government and health authority recommendations re. COVID-19 are displayed on notice boards and in breakout and meeting rooms.
	|_|
	|_|






Disclaimer 
The information contained in this document has been prepared by the Victorian Chamber of Commerce and Industry in this format for the convenience and benefit of its members and is provided as a source of information only. The Victorian Chamber does not accept responsibility for the accuracy of the information or its relevance or applicability in particular circumstances. The information does not constitute, and should not be relied on, as legal or other professional advice about the content and does not reflect the opinion of the Victorian Chamber, its employees or agents. The Victorian Chamber and its employees, officers, authors or agents expressly disclaim all and any liability to any person, whether a member of the Victorian Chamber or not, in respect of any action or decision to act or not act which is taken in reliance, whether partially or wholly, on the information in this communication. Without limiting the generality of this disclaimer, no responsibility or liability is accepted for any losses incurred in contract, tort, negligence, or any other cause of action, or for any consequential or other forms of loss. If you are uncertain about the application of this information in your own circumstances you should obtain specific advice.
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